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Doppler	Sonography	(vascular	measurements)
Introduction

Doppler	sonography	is	a	non-invasive,	painless	and	easily	accessible	ultrasound	based	diagnostic	method	for
measuring	velocity	of	blood	flow	in	the	vascular	system	by	bouncing	ultrasound	off	circulating	red	blood	cells	and
using	the	Doppler	effect.	It	is	used	to	examine	the	blood	vessels	of	the	neck,	the	limbs	and	organs	(for	example,
diagnosing	varicose	veins,	thrombosis,	arterial	blockages	in	upper	and	lower	limbs,	and	blood	vessels	mainly	in	the
brain),	but	also	in	childbirth	and	neonatal	medicine.	Doctors	consider	the	Doppler	sonography	as	a	big	step	forward
in	the	diagnosis	of	vascular	diseases.	A	regular	ultrasound	machine	uses	sound	waves	to	produce	images,	but	does
not	measure	blood	flow.	In	recent	years,	the	capabilities	of	ultrasound	flow	imaging	have	increased	enormously.
Color	flow	imaging	is	now	commonplace	and	facilities	such	as	‘power’	Doppler	provide	new	ways	of	imaging	flow.
With	such	versatility,	it	is	tempting	to	employ	the	technique	for	ever	more	demanding	applications	and	to	try	to
measure	increasingly	subtle	changes	in	the	maternal	and	fetal	circulations.	To	avoid	misinterpretation	of	results,
however,	it	is	essential	for	the	user	of	Doppler	ultrasound	to	be	aware	of	the	factors	that	affect	the	Doppler	signal,
be	it	a	color	flow	image	or	a	Doppler	sonogram.

A	Doppler	ultrasound	may	help	diagnose	many	conditions,	including:

Blood	clots
Poorly	functioning	valves	in	your	leg	veins,	which	can	cause	blood	or	other	fluids	to	pool	in	your	legs	(venous
insufficiency)
Heart	valve	defects	and	congenital	heart	disease
A	blocked	artery	(arterial	occlusion)
Decreased	blood	circulation	into	your	legs	(peripheral	artery	disease)
Bulging	arteries	(aneurysms)
Narrowing	of	an	artery,	such	as	in	your	neck	(carotid	artery	stenosis)

Competent	use	of	Doppler	ultrasound	techniques	requires	an	understanding	of	three	key	components:

(1)	The	capabilities	and	limitations	of	Doppler	ultrasound;	(2)	The	different	flow	parameters	that	can	be	measured;
(3)	Blood	flow	in	arteries	and	veins.

The	probe	(also	known	as	transducer)	is	a	necessary	component	in	an	ultrasound	system.	The	transducer	has	a
piezoelectric	crystal	that	has	the	ability	to	emit	and	to	detect	ultrasound	waves.	The	function	of	the	probe	is	to
send	ultrasound	energy	into	the	body	and	then	receive	the	reflected	signal	echoes.

Theory

Doppler	effect

The	Doppler	effect	is	the	change	in	the	frequency	of	the	ultrasound	when	it	is	reflected	off	a	moving	object	e.g.,	red
blood	cells.	If	the	blood	cells	are	moving	towards	the	transducer	the	frequency	becomes	higher,	if	moving	away
from	the	transducer	the	frequency	is	lowered.

Doppler	measurements	in	medicine

During	a	Doppler	sonography	procedure,	the	Doppler	effect	can	be	observed	in
the	reflection	of	ultrasound	waves	off	reflecting	structures	in	flowing	blood	such	as	erythrocytes.	The	frequency	of
reflected	waves	differs	from	the	transmitted	wave	due	to	the	movement	of	the	reflector.	If	the	blood	flows	towards
the	source	of	the	waves	-	towards	the	ultrasonic	probe,	then	the	frequency	of	the	reflected	waves	is	higher	than
the	transmitted	frequency,	if	the	blood	flows	in	a	direction	away	from	the	transducer,	the	frequency	is	lowered.
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We	do	not	measure	the	actual	velocity	but	only	the	velocity	component
parallel	to	the	probe.	Therefore,	if	the	blood	flow	measuring	probe	is
located	perpendicular	to	the	vessel,	it	measures	zero	speed.	Reflection
occurs	at	the	wall	of	the	blood	vessel	and	scattered	from	off	the	moving
erythrocytes	-	the	amount	of	waves	that	gets	back	to	the	probe	is	small
(the	blood	is	almost	anechoic),	but	it	is	enough	to	determine	the
frequency	shift;	and	from	that	it	is	possible	to	derive	the	flow	rate	of	the
blood	as	well	as	the	nature	of	the	flow	(laminar,	turbulent).

In	general,	Doppler	measurements	can	be	performed	in	two	modes
continuous	wave	(CW)	or	pulsed	wave	(PW).	Small	hand	held	Doppler
devices	such	as	the	one	used	in	this	experiment	use	CW	Doppler	whilst
2D/3D	Doppler	imaging	devices	use	PW	systems.	In	PW	systems	the
transmitter	transmits	in	pulses.	This	mode	allows	you	to	not	only	measure
the	frequency	change	between	the	transmitted	and	received	signals,	but

also	the	time	the	reflected	signal	takes	to	return	to	the	probe.	The	time	lag	between	the	impulse	sending	and
capturing	its	reflection,	determines	the	depth	at	which	the	flow	rate	has	been	measured.	The	result	is	displayed	as
a	two-dimensional	image	of	measured	speeds.

Blood	flow	parameters

Some	blood	flow	parameters	that	can	be	measured	are:

Maximum	systolic	velocity	(S)-	maximum	velocity	in	systole.

Minimum	diastolic	velocity	(D)-	minimum	velocity	of	the	flow	at	the	end	of	the	diastole

Mean	velocity	V-mean.

S/D	ratio	(systolic	/	diastolic	ratio)

Resistive	index	RI	(resistance	index)	=	(S-D)/S

Increase	in	RI	indicates	increased	resistance	to	blood	flow	leading	to	a	reduction	of	the	diastolic	velocity.	The
resistance	index	may	provide	information	on	the	efficiency	of	the	patients	blood	flow	and	whether	arteries	show
abnormal	properties	or	not	.	A	value	of	≈	0.60	is	considered	as	normal,	however	a	value	above	0.70	indicates	that
the	patient	may	have	a	condition	such	as	renal	artery	disease.

Pulse	index	PI	(pulsatility	index)	=	(S-D)/VMean

Different	arteries	have	different	values	and	factors	such	as	age,	fitness	and	even,	as	suggested	by	some	studies,
the	emotional	stage	of	the	patient.

Heart	rate	HR	(heart	rate)	is	the	number	of	heart	beats	per	unit	time,	most	often	per	minute.	HR	=	1	/	T	where	T
is	the	length	of	the	heart	period.

Protocol

During	this	practical,	you	will	be	working	with	a	simple	CW	Doppler	device	used	to	measure	the	velocity	of	blood	in
arteries	at	a	given	location	-	the	Bidop	Hadeco	(ES-100V3)	portable	Doppler	ultrasonic	measuring	device.	You	can
watch	a	video	of	the	use	of	such	a	device	here	https://www.youtube.com/watch?v=Zq20f0z65Xg

If	it	is	not	already	connected,	connect	the	Bidop	device	to	your	computer	using	a	USB	cable.	There	are	only	two
ports	on	the	device	with	a	directional	label.	To	connect	your	device	to	the	computer,	use	the	port	with	the	output
symbol.

Run	the	Smart-V-Link	software	using	the	desktop	icon.	Fill	out	the	data	on	the	home	screen.	Disregard	the
automatically	computed	data,	fill	in	all	information	manually	(basic	information	is	sufficient),	and	save.	Continue	to
the	program	home	page.

Remove	the	black	cap	from	the	probe.

Hold	the	small	button	on	the	probe	to	turn	it	on.

In	Settings,	set	the	device	to	communicate	with	the	computer	(COM).	The	access	can	be	connected	via	any	USB
port	on	the	computer.	(In	order	for	this	option	to	be	available,	it	is	necessary	to	switch	on	the	measuring	device.)	If
the	option	does	not	appear	even	when	the	device	is	turned	on,	press	Search	Comm.	Once	found,	return	to	the	main
screen.

Apply	a	thin	layer	of	gel	to	the	probe	(approx.	3	mm	thick).

For	the	purpose	of	this	practical,	the	Individual	Waveform	is	the	most	appropriate	measurement	setting.	However,
in	practice	there	are	alternative	methods	for	data	collection.	(For	example,	with	Venous	Doppler	it	is	possible	to
measure	and	compare	venous	flow	in	both	limbs)

Double-click	on	the	gray	field	on	the	screen	and	device	will	start	to	measure	.	The	values	​​will	appear	on	the	screen
as	a	moving	curve.
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Place	the	probe	at	an	angle	of	approximately	45°	against	the	flow	of	blood	and	try	to	find	the	brachial	pulse	by	the
brachial	artery	situated	near	the	elbow	on	the	upper	arm.

Turn	the	dial	on	the	device	to	adjust	the	volume	so	that	you	can	orient	yourselves	aurally	as	well.	When	you	find
the	location	of	an	artery,	the	probe	will	emit	a	whistle-like	sound.

Hold	the	probe	steadily	in	place	and	wait	until	the	field	on	the	screen	is	fully	filled	with	a	periodic	waveform.
Continue	measuring	until	you	have	at	least	peaks,	then	end	the	measurement	by	briefly	pressing	the	small	button
on	the	probe.

Press	Decision.	You	will	see	the	values	​​at	the	top	of	the	screen	that	you	will	later	use	to	fill	in	your	log.	Save	the
graph	via	PrintScreen	on	the	keyboard.	This	file	can	be	printed	directly.

Be	sure	to	clean	off	any	residual	gel	from	the	probe	before	leaving	your	station.

Processing	of	Individual	Measurement	Results

Once	you	have	finished	the	measurements	with	Smart-V-Link,	open	the	print	screen	by	pressing	the	PrtSc	key.

Import	the	PrintScreen	graph	into	GIMP	(Ctrl+v).	From	here,	you	will	transfer	your	values	​​into	the	Excel	sheet.

Cut	the	image	either	by	selecting	the	Trim	tool	(Ctrl+Shift+C)	directly	on	the	keyboard	or	by	the	path:	Tools	→
Transformation	Tools	→	Trimming	and	Dimensions.

Copy	the	“Doppler	new”	Excel	spreadsheet	to	the	desktop	and	rename	it	using	the	name	of	your	group.	Then,	open
it	and	write	the	measurement	results	from	the	in	the	yellow	fields.

First	calibrate.	Place	the	cursor	at	point	0,	where	the	pixel	coordinates	{X:Y}	will	appear	in	the	lower	left	bar.	Copy
these	coordinates	to	the	first	table.	In	a	similar	fashion,	fill	in	all	subsequent	calibration	values.	(Note:	the	end	of
diastole	is	equal	to	the	onset	of	systole.)

At	the	bottom	right	of	the	Excel	sheet	will	be	the	manually	retrieved	values,	which	are	calculated	from	the	table
macros.	Fill	in	the	yellow	boxes	next	to	the	manual	values	with	the	automatic	values	recorded	​​in	the	Smart-V-Link
program.	You	can	find	these	values	at	the	top	of	your	graph	when	you	clicked	the	Decision	tab.

Compare	the	results.

Save	the	file	(File->Save	as)	in	.bmp	format	on	the	desktop	(for	easier	access).	This	makes	the	file	ready	for
printing.

Print	both	the	graph	and	the	Excel	table.	Drag	all	saved	files	into	the	desktop	folder	labeled:	“Results.”

Information	for	Automatic	and	Manually	Measured	Values

Measured	Pulse	Wave	Parameters:

HR	(Heart	Rate)

RI	(Resistance	Index)

SD	(Systolic	/	Diastolic	ratio	=	S	/	D	ratio)

MEAN	(Mean	Flow	=	average	velocity	[Vmean])

PI	(Pulsatility	Index	=	pulse	index)

Important	Notes	for	the	Protocol

DO	NOT	use	this	device	on	the	chest,	abdomen,	head,	or	neck	area.

To	prevent	any	unwanted	reflection	of	ultrasound	waves,	apply	a	layer	of	gel	to	the	contact	tip	of	the	probe	about	3
mm	thick.	For	the	waves	to	penetrate	better	in	a	solid	medium	than	air	medium,	the	ultrasound	gel	enables	the
waves	to	transmit	directly	to	the	targeted	tissue	providing	coupling	between	the	skin	and	the	probe	as	a	type	of
conductive	medium.	Once	the	gel	begins	to	dry,	apply	a	new	layer.	However,	if	the	gel	covers	too	much	dermal
surface	area,	the	probe	may	not	record	properly.

While	using	the	probe,	carefully	and	patiently	locate	the	signal.	The	place	for	examination	is	good	in	advance,	for
example,	as	a	place	where	you	can	feel	the	pulse	with	the	fingers.

Do	not	move	the	probe	after	finding	the	appropriate	probe	location	(unlike	2D/3D	sonography).

The	program	may	unexpectedly	stop	(program	not	responding).	Typically,	you	can	resolve	the	issue	by	restarting
the	program	without	further	problems.

Protocol	Preparation



To	prepare	for	the	protocol,	use	the	form	found	under	P8	-	Doppler	Practical	on	Moodle.	Just	before	the	start	of
taking	measurements,	fill	in	the	boxes	noting	the	order	of	the	examiner	and	patient,	the	team	number,	the	date,
the	start	time	of	the	examination,	the	investigated	artery,	and	the	investigated	side	(i.e.-	sin	means	left,	dx	right).
At	the	end	of	the	experiment,	record	the	end-time	of	the	examination.

Write	down	the	measured	values	​​from	the	experiment	straight	into	the	data	table.

In	the	discussion,	compare	your	calculated	values	​​with	the	automatically	calculated	and	any	theoretical
assumptions	you	had	about	your	measurements.	Also,	mention	the	fact	that	affects	the	outcome	of	the
examination.

In	the	conclusion,	briefly	state	whether	the	result	of	your	measurement	corresponds	to	a	normal	finding	and
whether	a	low-resolution	or	high-resolution	curve	was	measured.

Conclusion

Over	the	course	of	the	last	half	decade	the	development	on	the	field	of	diagnostic	ultrasound	has	been	rapid,	the
newest	technology	being	3D-imaging.	Doppler	sonography	improves	diagnosis	due	to	provision	of	immediate
clinical	information,	hence	the	reduction	of	wrong	diagnosis	consequently	a	reduction	of	harm	to	the	patient	which
could	be	caused	by	wrong	treatments.	On	the	financial	side	the	immediate	result	reduce	overall	healthcare	costs.
All	in	all	Doppler	sonography	is	a	great	tool	to	use	to	provide	initial	provisional	diagnoses,	and	a	tool	to	give
direction	to	further	tests.
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